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Attach the clamp (sold 
separately) using the 
base mounting holes and 
M3 screws. 

MOUNTING OPTIONS 
Clamp Mounting 
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Secure the product to the 
surface using the base 
mounting holes and M3 
screws. 

Screw Mounting 
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Apply the double-sided 
tape to either side of 
the product, then press 
the product firmly onto 
the surface to secure it 
in place. 

Adhesive Mounting 
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Screw the product 
directly to the cabinet or 
panel as shown here. 

Cabinet Mounting / Panel Mounting 
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PRODUCT SPECIFICATIONS 

 

 
What’s in the box? 

- Switch Panel 
- USB Type-A to Type-B Cable 
- Double-sided VHB Tape 
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Product Weight/Dimensions 
Dimensions (L x W x H): 
200mm × 78.6mm × 219mm / 7.87in × 3.09in × 8.62in 
Weight: 
2.07lbs / 943g 

 
 
 
 

 

 

 
All dimensions shown in the image are in mm 
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Panel hole dimensions (W x H): 
190mm × 209mm / 7.48 in × 8.23 in 

 

 

All dimensions shown in the image are in mm 
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Safety, Maintenance, and Care Guidelines 
 

To ensure safe use and extend the lifespan of the Switch Panel follow these 
recommendations: 

 
Safety Precautions 

● Proper Use: Keep the unit dry and free from moisture. Use only certified USB power 
sources. 

● Heat & Ventilation: Avoid placing the device near heat sources or in direct sunlight.  
● Material Care: Avoid solvents or abrasive cleaners; plastic parts can deform above 60–

65°C (140–149°F). 
● Handling: Handle device carefully to avoid damage. Keep out of reach of 

children and pets. 
● Disposal: Follow local recycl ing rules for electronics and plastics. 
● Warranty: Unauthorized modification or disassembly may void t h e  warranty. 

Contact support for approved repairs or servicing. 

 
Maintenance and Care 

● Surface Cleaning: Use a soft, dry microfiber cloth to clean exterior surfaces. Avoid liquid 
cleaners and alcohol-based solutions. 

● USB Port Care: Ensure USB Type B connection remains secure and free from debris. 
Minimize unnecessary unplugging to reduce port wear. 

● Storage: Store in a dry, dust-free environment away from direct sunlight when not in 
use. 
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Setup Instructions 
 

 

 
1) (Optional) Mount the Device 

Refer to the Mounting Options section of this manual for instructions on securing the 
device. 

 
2) Establish USB Communication 

a) Connect the Type-B end of  the inc luded USB cable to the Switch Panel. 
b) Connect the Type-A end to a USB por t  on your PC. 

 

3)  (Optional) Supply LED Power to Connected Products 
Connect a 5V DC power adapter to the Switch Panel’s PWR IN port and plug it into a 
power outlet to power compatible Desktop Pilot products with controllable LED 
lighting (e.g., the Pedestal Fuel Tank Selector).  
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Setup Instructions 
 

 

 
 

Software Setup & Configuration 
 

Complete setup based on the flight simulator software you are using: 
 

Option A: Setup for X-Plane 11………………………………………………………..page 11 
Option B: Setup for X-Plane 12………………………………………………………...page 16 
Option C: Setup for Microsoft Flight Simulator 2020 (MSFS 2020)……………….page 23 
Option D: Setup for Microsoft Flight Simulator 2024 (MSFS 2024)……………….page 24 
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Setup Instructions 
 

 

 

OPTION A: SETUP FOR X-PLANE 11 
 

4) Configure the Switch Panel in X-Plane 11 

● Go to X-Plane’s Settings and navigate to the Joystick tab. 
● In the device list, click the dropdown menu and select “Switch Panel” 

 

 
● If the message “Uncalibrated Device” appears, calibrate the Desktop Pilot Switch Panel by 

rotating each of the four dimming knobs through its full range of motion. 
● Now assign the buttons as follows: 

1. Btn 0 → Search for "Battery 2 on" and assign it. 
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2. Btn 1 → Search for "Battery 2 off" and assign it. 
3. Btn 2 → Search for "Test all annunciators" and assign it. 
4. Btn 3 → Search for "Generator #1 on" and assign it. 
5. Btn 4 → Search for "Generator #1 off" and assign it. 
6. Btn 5 → Search for "Battery 1 on" and assign it. 
7. Btn 6 → Search for "Battery 1 off" and assign it. 
8. Btn 7 → Search for "Avionics on" and assign it. 
9. Btn 8 → Search for "Avionics off" and assign it. 
10. Btn 9 → Search for "Do nothing" and assign it. 
11. Btn 10 → Search for "Do nothing" and assign it. 
12. Btn 11 → Search for "Beacon lights on" and assign it. 
13. Btn 12 → Search for "Beacon lights off" and assign it. 
14. Btn 13 → Search for "Landing lights on" and assign it. 
15. Btn 14 → Search for "Landing lights off" and assign it. 
16. Btn 15 → Search for "Taxi lights on" and assign it. 
17. Btn 16 → Search for "Taxi lights off" and assign it. 
18. Btn 17 → Search for "Nav lights on" and assign it. 
19. Btn 18 → Search for "Nav lights off" and assign it. 
20. Btn 19 → Search for "Strobe lights on" and assign it. 
21. Btn 20 → Search for "Strobe lights off" and assign it. 
22. Btn 21 → Search for "Fuel pump for engine #1 on" and assign it. 
23. Btn 22 → Search for "Fuel pump for engine #1 off" and assign it. 
24. Btn 23 → Search for "Anti-ice: left pitot heat on" and assign it. 
25. Btn 24 → Search for "Anti-ice: left pitot heat off" and assign it. 
26. Btn 25 → Search for "Do nothing" and assign it.  
27. Btn 26 → Search for "Do nothing" and assign it. 

Optional: For Btn 25 and Btn 26, search for and assign “Pause the Simulation.” This allows 
the Cabin Power 12V switch to function as a shortcut for pausing the simulator. 
 

● Once assignments are complete, click “Done” in the bottom right corner of the screen. 
 

5) Install Switch Panel Plugin 
Note: X-Plane does not include built-in commands for the dimming knobs. To enable 
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this functionality, you must install the Desktop Pilot Switch Panel plugin. 
● To download the plugin, go to:  

www.desktoppilot.com/manuals/switch-panel-user-manual/  
Then click the DOWNLOAD SP PLUGIN FOR X-PLANE button: 

 
  

● Once the download is complete, right-click the DesktopPilotSP folder and select 
Extract All...  

● Copy (or drag and drop) the extracted DesktopPilotSP folder into the X-Plane Plugins folder.  

To locate the Plugins folder: 

1. Open your main X-Plane 11 folder.  
2. Open the Resources folder.  
3. Open the Plugins folder.  
4. Paste the DesktopPilotSP folder inside.  

Example X-Plane 11 Plugins Folder Locations 

http://www.desktoppilot.com/manuals/switch-panel-user-manual/
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• C:\Program Files (x86)\Steam\steamapps\common\X-Plane 11\Resources\plugins  
• or C:\X-Plane 11\Resources\plugins  

Note: Once the folder has been added, you can close the X-Plane folder window. 

 

● Open X-Plane and Start Flight.   
● Once at the cockpit screen, the Desktop Pilot Brightness Axis Configuration window will 

automatically open. (Tip: To reopen after closing navigate to: Plugins → DesktopPilot Brightness → 
Configure Axes...) 

 

 
 

● Four brightness controls are available: 
Avionics - Avionics panel brightness 
SWBC  - Switch/Warning/Breaker/Circuit panel brightness 
Pedestal - Pedestal panel brightness 
STBY - Standby instruments brightness 
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● To assign each brightness control: 
o Click Assign next to the control name 
o The status will change to: “Move the axis for [CONTROL NAME]...”  
o Rotate the corresponding dimming knob on the Desktop Pilot Switch Panel.  
o The display will show: “Axis [number] [current value]” 

● Optional Settings: 
o Check Rev to reverse axis direction (clockwise dims instead of brightens) 
o Click Clear to remove an assignment 

● Saving Configuration 
o Click Save Config 
o Your configuration will automatically load the next time X-Plane starts  
o You can close the window — the axes will continue to function 

Tips 
● Axis numbers (such as “Axis 50” or “Axis 51”) are X-Plane’s internal axis labels and are normal.  
● Click Refresh Devices if the axes stop responding after reconnecting the device.  
● Use Load Config to restore a previously saved configuration. 
● Use Clear All to remove all assignments at once.  
● The configuration window opens automatically each flight; after initial setup, simply close it. 
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Setup Instructions 
 

 

 
OPTION B: SETUP FOR X-PLANE 12 

 
4) Configure the Switch Panel in X-Plane 12 

● Go to X-Plane’s Settings and navigate to the Joystick tab. 
● In the device list, click the dropdown menu and select “Desktop Pilot - Switch Panel” 

 

 
● If the message “Uncalibrated Device” appears, calibrate the Desktop Pilot Switch Panel by 

rotating each of the four dimming knobs through its full range of motion. 
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● Now assign the buttons as follows: 
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● Once assignments are complete, click “Done” in the bottom right corner of the screen. 
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5) Install Switch Panel Plugin 
Note: X-Plane does not include built-in commands for the dimming knobs. To enable 
this functionality, you must install the Desktop Pilot Switch Panel plugin. 

● To download the plugin, go to:  
www.desktoppilot.com/manuals/switch-panel-user-manual/  
Then click the DOWNLOAD SP PLUGIN FOR X-PLANE button: 

 
● Once the download is complete, right-click the DesktopPilotSP folder and select 

Extract All...  
● Copy (or drag and drop) the extracted DesktopPilotSP folder into the X-Plane Plugins folder.  

To locate the Plugins folder: 

• Open your main X-Plane 12 folder.  
• Open the Resources folder.  
• Open the Plugins folder.  
• Paste the extracted DesktopPilotSP folder inside.  

http://www.desktoppilot.com/manuals/switch-panel-user-manual/
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Example X-Plane 12 Plugins Folder Locations 

• C:\Program Files (x86)\Steam\steamapps\common\X-Plane 12\Resources\plugins  
• or C:\X-Plane 12\Resources\plugins  

Note: Once the folder has been added, you can close the X-Plane folder window. 

● Open X-Plane and Start Flight.   
● Once at the cockpit screen, the Desktop Pilot Brightness Axis Configuration window will 

automatically open. (Tip: To reopen after closing navigate to: Plugins → DesktopPilot Brightness → 
Configure Axes...) 

 

 
 

● Four brightness controls are available: 
Avionics - Avionics panel brightness 
SWBC  - Switch/Warning/Breaker/Circuit panel brightness 
Pedestal - Pedestal panel brightness 
STBY - Standby instruments brightness 
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● To assign each brightness control: 
o Click Assign next to the control name 
o The status will change to: “Move the axis for [CONTROL NAME]...”  
o Rotate the corresponding dimming knob on the Desktop Pilot Switch Panel.  
o The display will show: “Axis [number] [current value]” 

● Optional Settings: 
o Check Rev to reverse axis direction (clockwise dims instead of brightens) 
o Click Clear to remove an assignment 

● Saving Configuration 
o Click Save Config 
o Your configuration will automatically load the next time X-Plane starts  
o You can close the window — the axes will continue to function 

Tips 
● Axis numbers (such as “Axis 50” or “Axis 51”) are X-Plane’s internal axis labels and are normal.  
● Click Refresh Devices if the axes stop responding after reconnecting the device.  
● Use Load Config to restore a previously saved configuration. 
● Use Clear All to remove all assignments at once.  
● The configuration window opens automatically each flight; after initial setup, simply close it. 
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Setup Instructions 
 

OPTION C – SETUP FOR MICROSOFT FLIGHT SIMULATOR 2020: 
 

4) Configure the Switch Panel in MSFS 2020 

● In MSFS, open the Options menu. 
● Select CONTROLS OPTIONS. 
● From the device list at the top, choose “Switch Panel.” 
● Search for the following functions and assign these commands:  

Note: when prompted, create a new input profile (e.g., “Desktop Pilot SWP”) and select 
“apply to all aircraft”): 

 
Function Assigned Value 
SET AVIONICS MASTER 2 10 
SET AVIONICS MASTER 1 8 
SET BATTERY 1 6 
SET BATTERY 2 1 
SET ELECTRIC FUEL PUMP 1 22 
SET ALTERNATOR 4 
SET PITOT HEAT 24 
SET TAXI LIGHTS 16 
SET STROBES 20 
SET NAV LIGHTS 18 
SET LANDING LIGHTS 14 
SET BEACON LIGHTS 12 

 
● After completing all assignments, click Apply & Save in the lower-left corner of the screen. 
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Setup Instructions 
 

 

OPTION D – SETUP FOR MICROSOFT FLIGHT SIMULATOR 2024: 
 

4) Configure the Switch Panel in MSFS 2024.  
 

● In MSFS, open the Settings menu by clicking the gear icon in the upper-right corner. 
● Select the Controls tab. 
● Ensure the selected aircraft is the Cessna 172 Skyhawk (G1000 variant). 
● If needed, change the aircraft by pressing G or selecting Change Aircraft. 
● On the left side of the screen, select “Switch Panel” from the device list. 
● Search for the following functions and assign these commands:  

Note: when prompted, create a new input profile (e.g., “Desktop Pilot SWP”) and 
(optional) select “apply to all aircraft”: 

 
Function Assigned Value 
SET TAXI LIGHTS 16 
SET STROBES 20 
SET NAV LIGHTS 18 
SET LANDING LIGHTS 14 
SET BEACON LIGHTS 12 
SET ALTERNATOR 4 
SET BATTERY 1 6 
SET BATTERY 2 1 
SET PITOT HEAT 24 
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For the following entries, select the command labeled Specific and Digital. 
 

Function Assigned Value 
ELECTRICAL BUS 1 TO AVIONICS BUS 1 OFF 9 
ELECTRICAL BUS 1 TO AVIONICS BUS 1 ON 8 
ELECTRICAL BUS 2 TO AVIONICS BUS 2 OFF 11 
ELECTRICAL BUS 2 TO AVIONICS BUS 2 ON 10 
STANDBY BATTERY INCREASE 3 
FUEL PUMP 1 OFF 2 
FUEL PUMP 1 ON 22 
ELECTRICAL SWITCH 12V POWER OFF 27 
ELECTRICAL SWITCH 12V POWER ON 26 
PANEL LIGHT 1 DIMMER JOYSTICK LAXIS X- 
PANEL LIGHT 2 DIMMER JOYSTICK LAXIS Y- 
PEDESTAL LIGHT DIMMER JOYSTICK LAXIS Z- 
POTENTIOMETER 5 DIMMER JOYSTICK RAXIS X- 
PANEL LIGHT 1 BRIGHTENER JOYSTICK LAXIS X+ 
PANEL LIGHT 2 BRIGHTENER JOYSTICK LAXIS Y+ 
PEDESTAL LIGHT BRIGHTENER JOYSTICK LAXIS Z+ 
POTENTIOMETER 5 BRIGHTENER JOYSTICK RAXIS X+ 

 
 
 

 
● Click Save and Back, return to the simulator, and test each control to verify proper operation. 
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Setup Instructions 
 

4) Install SkySync and Calibrate  
Note: MSFS does not include built-in commands for the dimming knobs. To enable 
this functionality, you must install the Desktop Pilot SkySync software. 
 

Important: Ensure that MSFS 2024 is closed before and during SkySync installation process. 
1. Visit https://www.desktoppilot.com/software/  

2. Download the latest version of SkySync for MSFS. 

 
3. Run the installer and complete installation. 

Tip: Pin SkySync to your Start menu or taskbar for quick access. 
 

4. Open SkySync, then select Plugin (top-right corner) → Insert. 
A pop-up message will confirm that the plugin was inserted successfully. Close SkySync. 

5. Open MSFS 2024 and start a new flight. 

https://www.desktoppilot.com/software/
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Setup Instructions 
 

 
6. Open SkySync. In the main window, click SkyView. A separate SkyView window will open. 
7. In the SkyView window, select Joystick. 
8. Click BIND AXIS. 
9. Select the axis you want to bind from the RAW AXIS DATA column.  
10. Click CALIBRATE. 
11. Rotate the corresponding knob on the Switch Panel to its’ minimum value. 
12. Rotate the corresponding knob on the Switch Panel to its’ maximum value. 
13. Repeat the same steps for any remaining knobs you wish to calibrate. 

IMPORTANT: Keep the SkySync and SkyView windows open (or minimized) in the background 
while using the simulator. 
Resetting Bindings 
To clear existing bindings, click RESET ALL in the calibration window. 
Note: After calibration is complete, verify the functionality inside the simulator to ensure that each 
axis responds correctly. 
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Troubleshooting Guidelines 
 

 

Problem: The green LED does not light up when the Standby Battery switch is in the 
TEST position. 
Solution: 

● Ensure the USB cable is properly connected to both the panel and the computer. 
● Check simulator settings to confirm the input is being registered. 
● Note: The LED will stay on only while the switch is in the TEST position. It will turn off 

when the switch is moved to another position. 

Problem: Dimming knobs do not adjust brightness of the panel or connected 
components. 
Solution: 

● Confirm the USB cable is connected and the device is recognized by the computer. 
● If controlling external components (e.g., Pedestal Fuel Tank Select), ensure a 5V 

power supply is connected to the PWR IN slot. 
● Make sure the passthrough cable (M to M DC) is securely connected between PDSTL 

ports. 

Problem: Specific switches do not trigger events or register as inputs. 
Solution: 

● Confirm that no other hardware connected to your simulator is assigned to the 
same functions or button bindings, as duplicate assignments may cause conflicts 
or unexpected behavior 

● Check the simulator’s input mapping menu and verify that the switch is being 
detected. 

● If not detected, test other switches to confirm general device function. 
● Disconnect and reconnect the USB cable, then restart the simulator software. 
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Frequently Asked Questions 
 

 

Is the Switch Panel compatible with simulator cockpit setups? 
Yes. The Switch Panel supports clamp mounting, direct screw installation, and adhesive VHB 
tape mounting. It is also compatible with the C172 Mounting Panel and Mounting Cabinet 
(sold separately). 

 
Is the Switch Panel compatible with Xbox? 
No. The Switch Panel is not supported on Xbox game consoles.  

 
Is the Switch Panel compatible with other flight sim peripherals? 
Yes. It functions as a standalone joystick and operates independently of other simulator 
hardware. Fully compatible with yokes, throttle quadrants, rudder pedals, avionics stacks, 
and other panels. 

 
Does the Switch Panel require an external power supply? 
No. All core functions operate via USB. However, connecting a 5V DC power supply to the 
PWR IN slot enables brightness passthrough to supported peripherals. 

 
Can the panel control external hardware brightness? 
Yes. When powered by a 5V DC input, the panel can pass brightness control to compatible 
devices via the PDSTL output, such as the Pedestal Fuel Tank Select module. 

 
How many buttons and axes does the Switch Panel have? 
The panel provides 27 mappable buttons and 4 analog axes, allowing extensive 
customization for simulator controls. 



 

 
 

 
 

Need Help or Have Suggestions? 
If you’re experiencing an issue not covered in this guide, would like to report a bug, or have ideas 

for improvement — we’re here to help. 
 

Contact Us 
Email: sales@desktoppilot.com 

Phone: +1-888-296-9150 
 

Support Hours 
Monday–Friday 

10:00 AM – 6:00 PM (EST) 
 

Visit Us Online 
https://www.desktoppilot.com/ 

 
 

Your feedback helps us improve the experience. Don’t hesitate to reach out — we’d love to hear 
from you! 

 
 
 

*Manuals and troubleshooting steps are updated periodically. To access the latest full version of 
this manual and updated troubleshooting tips, visit: 

https://www.desktoppilot.com/manuals/ 

https://www.desktoppilot.com/
https://www.desktoppilot.com/manuals/
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